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Most of above labels are self explanatory. Below is the description needed for some of the labels. Also 
check brief Introduction of 8051(AT89S52) & Schematic of the Kit in following pages for detail 
understanding.

1. Microcontroller (AT89S52) – This Kit comes with 89S52 IC, but it can support any 8051 based 40 pin IC.

3. USB-C Power Connector – It is a USB-C connector. This board can be powered by USB C +5V adapter.

2. ISP Programmer Connector  –  It is used to connect USB ISP Programmer to program the MCU.

6. UDB Conn:These connectors are used to attach this kit to ‘Universal Development Board(UDB)’ by 
                         Amotech Labs. Check UDB details on our website.
9. 4x4 Keypad – The 4x4 Keypad is connected to Port 2 of 8051 MCU. 

10. 7 Segment Display – It is optionally connected to Port 0 of MCU. Port 0 values will reflect on it, when it’s  

11.Vref Vtg. Pot. – This Connector can be used to insert 10k pot. to adjust the  ADC ref.(Vref) voltage for 

12.Analog I/P Vtg. Pot. – In this connector we can insert 10K pot. or Lm35 sensor to give variable analog 
Input voltage input to ADC0804.
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 Overview of 8051 Development Board Kit:

3.USB C  

4. Reset Sw  

1. Any 8051 based MCU  2. ISP Programmer Connector

6. UDB Conn.

5. MCU Ports

7. 10K LCD 
Contrast

8. 16x2 LCD

9. 4x4 Keypad

10. 7 Segment Display.
   with GND Jumper

11.Vref.  Vtg. Pot. 

12.Analog I/P Vtg. 
Source Conn.

 14. +5V & GND Conn. 

Pot.

    Power Conn.  

             ISP Programmer

13.ADC0804 IC Slot 

Conn.

    ( 89S52 IC)  

    Power Conn.  

    jumper is inserted. The jumper connects 7 Seg. Displays Common Cathode to GND. 

ADC0804. When this Pot. is not inserted, by default Vref is 5V, if external Vref is not given. 
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 ‘8051  Development Board’ can be mounted on below UDB Kit:   
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 ‘8051 Development Board’ mounted on UDB Kit’s Slot 1 can be seen in the below    
 UDB Kit which has DC, Servo and Stepper Motors mounted on-board.    

Note: This Kit was assembled for College Lab use in Wooden Box Enclosure. That’s why it is fitted on      

 For Students, only UDB  is also available to buy with ‘UDB 2 Wheel Robot  Acrylic Sheet’.     
 Students can configure the UDB by adding the peripherals as per their application needs.      

          a Acrylic Sheet with Motors mounted on it for studying their interfacing using 8051 MCU & UDB.     



 Introduction to AT89S52 Microcontroller

:  

Features of AT89S52: 

✓ Operating Frequency :  DC 33 MHZ
✓ Program Memory (Bytes): 8K

✓ Program Memory (Instructions) : 8192 

✓ Data Memory (Bytes): 256

✓ Data EEPROM Memory (Bytes) :  Not available 

✓ Interrupt Sources : 6 

✓ I/O Ports : 4(PORT 1 ,PORT 2 ,PORT 3 , PORT 4) 

✓ Timers : 3 (16 Bit each) 
✓ Capture/Compare/PWM Modules : No 

✓ Enhanced Capture/ Compare/PWM Modules : No

✓ Serial Communications : UART

✓ Universal Serial Bus (USB) Module : No

✓ Streaming Parallel Port (SPP) : No 

✓ 10-Bit Analog-to-Digital Module : No

✓ Comparators : No 

✓ Programmable Low-Voltage Detect :  No 

✓ Instruction Set : 255

✓ Packages :  40-pin DIP, 44-pin PLCC , 44-pin TQFP
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                                       Keil IDE for Programming of 8051 (AT98S52) MC

Below are the steps to program any AT89S52 code
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“2. Create New Project” window will pop up, type a project name and location for the project and save.

1.Select New µVision Project from the Project Menu.
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3.“Select Device for Target” window will pop up, select your device (here we selecting AT89S52)

4.“µVision” window will ask for copy STARTUP.A51 to the project folder and add a file to the project 
 (If necessary you can select “No” but we recommended you to select “Yes” because it will help to run the 
program smoothly. )
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5.Now select New file from the File menu and type your program code (here we have typed LED 
blinkingprogram)

6.Save program code with “.c“ extension (In case if you are using assembly language then save
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7 .Right-click on Source Group 1 folder from Target 1 and select “Add existing files to Group 
    ‘Source Group 1’”

8.Select the program file saved with “.c “or “.asm” (in case of assembly language) and add it. Then 
   close that window. You can see the added file in the “Source Group 1” folder in the left project window.
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9..Now select the Project menu and click on “Build target”, it will build a project and give status in 
    the Buildoutput window with Error and Warning count if any.

10.To create a Hex  file right click on Target 1 and select Option for Target ‘Tar
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11.The target window will pop up, enter Xtal (MHz) frequency (here we used 11.0592 MHz), and tick
      mark in front of the “Use On-chip ROM” tag.

12. Within the same window select the “Output” option and tick mark in front of the “Create Hex File” tag

      and click on OK.
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13 .Now again select build target from the Project menu or simply hit the F7 shortcut key for the same, 
      it will build target and also create a Hex file. You can see creating a Hex file in the Build output window

14. Check Video Tutorials on our YouTube Channel, for Instructions of Installing ISP Programmer    
      Drivers, Compiling the program and Downloading the Hex File into our 8051 Development Boards.   

                                           In Videos for ‘8051 Development Boards’, under their description you will also find a Google Drive Link 

      YouTube Channel:                                               https://www.youtube.com/@AmotechLabs

                                           to download ISP Programmer, Drivers, Programmer Software Files, Sample Programs and Schematic. 



     

            Lab 1 - LED Blinking                                                                            

  Aim: To study the LED’s Interfacing with AT89S52 and blink them in different patterns with delay.  

 

Procedure:

1. Read the LED Blink Program on the next page with all the comments explaining the code.

2. Open the Project folder in Keil µVision IDE or create a new project following the Keil manual. 

3. Build the project and generate the HEX file.Use Keil Programmer or another suitable tool to 

download the HEX file to the 8051 microcontroller.

4. Ensure that the LED Ground jumper is properly inserted to provide ground to all the LED’s cathode 

pins.                                       
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Program:

1.      #include<reg52.h> // special function register declarations
2.
3.  LED1 = P1^ ;     sbit 0  //LED pin
4. delay(  count);void unsigned int
5.  main ( )void void
6. {
7.   (1) // infinite loopwhile
8.  {
9.    LED1 = ;0
10.   P0 = ;0x00
11.   delay( ); 1000
12.   LED1 = ;1
13.   P0 = ;0xFF
14.   delay( );1000
15.   }
16. }
17.//delay function generates delay in millisecond.
18.  delay(  count)void unsigned int
19.{
20. i,j; int 
21. (i=0;i<count;i++) for
22. (j=0;j<112;j++); for
23.}



     

    Aim: To study the Interfacing SSD(Seven Seg. Displays) with AT89S52 by doing SSD Counter Program.  

 

Procedure:  

1. Read the SSD Counter Program with comments explaining the code.
2. Open the Project folder in Keil µVision IDE or create a new project following the Keil manual. 
3. Build the project and generate the HEX file.Use Keil Programmer or another tool to download 

the HEX file to the 8051 microcontroller.
4. Insert the SSD Ground jumper to provide ground to both SSDs.                                      

17

AMOTECH LABS
Sharing Enthusiasm for Embedded Systems & Automa�on. 

 +91-8329537565  amotechlabs@gmail.comwww.amotechlabs.com

 Embedded/IoT Development | Automa�on Sevices | Training & Counselling
 Embedded Development Boards/Kits |PLC & Automa�on raining Staa�onsAMOTECH

     LABS

            Lab 2 - SSD Counter                                                                            

  



Program:
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1. #include<reg52.h>        // special function register declarations
2.
3. sbit LED1 = P1^ ;         0  //LED pin
4. void unsigned intdelay(  count);
5. unsigned char I;
6. // Segment patterns for digits 0-9 (Common Cathode)
7. unsigned char segment_code[] = {0x3F, 0x06, 0x5B, 0x4F, 0x66, 
8.                                                       0x6D, 0x7D, 0x07, 0x7F, 0x6F};
9. void void main ( )
10.{
11.  (1)     while // infinite loop
12.  {
13.   for (i=0;i<10;i++)
14.   {
15.     P0 = segment_code[i];
16.     delay( ); 1000
17.   }
18. 
19.   delay(1000);
20.  }
21.}
22.//delay function generates delay in millisecond.
23.void unsigned int delay( count)
24.{
25. int i,j;
26. for(i=0;i<count;i++)
27. f (j=0;j<112;j++);or
28.}



     

   

      
                                                                        
 

 Aim: To study the 16x2 LCD Interfacing with AT89S52.  

 

.Procedure:  

1. Read the LCD Interfacing Program with all comments explaining the code. 
2. Open Keil µVision, create/open a project for 8051 (AT89C51), write the program, and build it to 

generate the Hex file.
3. Use Flash Magic (or another programmer) to download the Hex file to the 8051 microcontroller.
4. Adjust the LCD contrast using the 10k pot. Once programmed and disconnected, the expected content 

will appear on the LCD.                                     
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            Lab 3 - LCD Interfacing                                                                            
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Program:

1. #include<reg51.h>
2.
3. D7=P3^7;  sbit //Ard D2
4. D6=P3^6;  sbit //Ard D3
5. D5=P3^5;  sbit //Ard D4
6. D4=P3^4;  sbit //Ard D5
7.
8. rs=P3^ ; sbit 2 /* Register select pin */  //Ard D8
9. en=P3^ ; sbit 3 /* Enable pin */           //Ard D7
10.
11.//#define LCD_Port P1
12. LCD_Port ;int 
13.
14./* Function to provide delay Approx 1ms with 11.0592 Mhz crystal*/
15. delay(  count)void unsigned int
16.{
17. i,j;int 
18. (i=0;i<count;i++)for
19. (j=0;j<112;j++); for
20.}
21.
22. LCD_Command (  cmnd)  void char /* LCD16x2 command funtion */
23.{
24.LCD_Port = (cmnd & )>>4;0xF0 /* Send upper nibble */
25.D7=LCD_Port& ;0X08
26.D6=LCD_Port& ;0X04
27.D5=LCD_Port& ;0X02
28.D4=LCD_Port& ;0X01
29.rs=0; /* Command reg. */
30.// rw=0; /* Write operation */
31.en= ;1
32.delay( );1
33.en= ;0
34.delay( );2
35.
36.LCD_Port = (cmnd & ); 0x0F /* Send lower nibble */
37.D7=LCD_Port& ;0X08
38.D6=LCD_Port& ;0X04
39.D5=LCD_Port& ;0X02
40.D4=LCD_Port& ;0X01
41.rs= ;0
42.en= ; 1 /* Enable pulse */
43.delay( );1
44.en= ;0
45.delay( );5
46.}
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47. LCD_Char (  char_data) void char /* LCD data write function */
48. 
49.  LCD_Port =(char_data & )>>4;/* Send upper nibble */ 0xF0
50. D7=LCD_Port& ;0X08
51. D6=LCD_Port& ;0X04
52. D5=LCD_Port& ;0X02
53. D4=LCD_Port& ;0X01
54. rs=1; /*Data reg.*/
55. // rw=0; /*Write operation*/
56. en= ;1
57. delay( );1
58. en=0;
59. delay( );2
60.
61. LCD_Port = ( _data & 0x0F);char /* Send lower nibble */
62. D7=LCD_Port& ;0X08
63. D6=LCD_Port& ;0X04
64. D5=LCD_Port& ;0X02
65. D4=LCD_Port& ;0X01
66. en=1; /* Enable pulse */
67. delay( );1
68. en= ;0
69. delay( );5
70. }
71. LCD_String (  *str) void char /* Send string to LCD function */
72.
73. I;int 
74. (i=0;str[i]!=0;i++)for  /* Send each char of string till the NULL */
75. {
76.  LCD_Char (str[i]); /* Call LCD data write */
77. }
78. }
79. LCD_String_xy (char row, char pos, char *str) void /* Send string to LCD function */
80. {
81. (row == )if 0
82. LCD_Command((pos & )| );0x0F 0x80
83.  (row == )else if 1
84. LCD_Command((pos & )| ); 0x0F 0xC0
85. LCD_String(str); /* Call LCD string function */
86. }
87. LCD_Init ( ) void void /* LCD Initialize function */
88. {
89. delay( ); 20 /* LCD Power ON Initialization time >15ms */
90. LCD_Command ( ); 0x02 /* 4bit mode */
91. LCD_Command ( ); 0x28 /* Initialization of 16X2 LCD in 4bit mode */
92. LCD_Command ( ); 0x0C /* Display ON Cursor OFF */
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93. LCD_Command ( ); 0x06 /* Auto Increment cursor */
94. LCD_Command ( );0x01  /* clear display */
95. LCD_Command ( ); 0x80 /* cursor at home position */
96. }
97.
98. void main()
99. {
100. LCD_Init(); /* Initialization of LCD*/
101.
102. LCD_String( );"AMOTECH LABS" /* write string on 1st line of LCD*/
103.
104.     LCD_Command(0xc0); /* Go to 2nd line*/
105.
106.     LCD_String("   ");PUNE     /*write string on 2nd line*/
107.
108.      delay( );1000
109.
110.
111. (1);  while /* Infinite loop. */
112. }



           
                                                                        
 

 Aim: To study the Interfacing of 4x4 Keypad with AT89S52.  

 

 

1. Read the Keypad Interfacing Program on the next page with all the comments explaining 
the program.

2. Open the Project folder for the program in Keil µVision IDE or create a new project 
following the procedure explained in the Keil manual. Build the project and generate the 
HEX file. 

3. Use Keil Programmer or another suitable tool to download the HEX file to the 8051 
microcontroller.             

4. If you entered the correct passkey then you will get acess otherwise you will get the 
message “Access denied”.                            
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            Lab 4 - 4x4 Keypad Interfacing                                                                            

Procedure:
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Program:

1. #include<reg51.h>
2. #include<string.h>
3.  lcdport #define P3
4.
5.  col1=P2^ ;sbit 3
6.  col2=P2^ ;sbit 2
7.  col3=P2^ ;sbit 1
8.  col4=P2^ ;sbit 0
9.  row1=P2^ ;sbit 7
10.  row2=P2^ ;sbit 6
11.  row3=P2^ ;sbit 5
12.  row4=P2^ ;sbit 4
13.  =P3^ ;sbitrs 2
14. en=P3^ ;sbit 3
15. buzzer=P1^ ;sbit 0
16. pass[ ],i= ;char 4 0
17.
18. delay(  itime)void int
19.{
20.    i,j;int 
21.    (i=0;i<itime;i++)for
22.  (j=0;j<1275;j++);  for
23.}
24. daten()void 
25.{
26.    rs= ;1
27.    en= ;1
28.    delay( );5
29.    en= ;0
30.}
31. lcddata(unsigned char ch)void 
32.{
33.    lcdport=ch & 0x ;f0
34.    daten();
35.    lcdport=(ch<<4) & 0x ;f0
36.    daten();
37.}
38. cmden(void)void 
39.{
40.    rs= ;0
41.    en= ;1
42.    delay( );5
43.    en= ;0
44.}
45.. lcdcmd(  ch)void unsigned char
46. {
47.    lcdport=ch & 

48.    cmden();
49.    lcdport=(ch<<4) & 0x ;f0
50.   cmden();
51. }
52. lcdstring(  *str)void char
53. {
54.    (*str)while
55.    {
56.   lcddata(*str);
57.   str++;
58.    }
59. }
60. lcd_init(void)void 
61. {
62.    lcdcmd(0x );02
63.   lcdcmd(0x );28
64.   lcdcmd(0x );0e
65.    lcdcmd(0x );01
66.}
67. keypad()void 
68.{
69.    int cursor= ,flag= ;192 0
70.    lcdcmd( );1
71.    lcdstring( );"Enter Ur Passkey"
72.    lcdcmd(0x );c0
73    i= ;0
75. (i<4)while
76.    {
77.    flag=cursor;
78.     col1= ;0
79.     col2=col3=col4= ;1
80.    (!row1) if
81.     {
82.       lcddata( );'1'
83.        pass[i++]='1';
84.        cursor++;
85.        (!row1);while
86.      }
87. (!row2)else if
88.     {
89.        lcddata( );'4'
90.       pass[i++]=' ';4
91.        cursor++;
92.        (!row2);while
93.        }
94.  (!row3)else if
95.   {
96.        lcddata( );'7'
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Program:

97.  pass[i++]='7';
98.        cursor++;
99.      (!row3);while
100.   }
110 (!row4)else if
111.   {
112.       lcddata( );'*'
113.        pass[i++]='*';
114.        cursor++;
115.      (!row4); while
116.        }
117.     col2=0;
118.     col1=col3=col4=1;
119.     (!row1)if
120.     {
121.        lcddata('2');
122.        pass[i++]='2';
123.        cursor++;
124       (!row1); while
125.        }
126. (!row2) else if
127.     {
128.        lcddata('5');
129.        pass[i++]='5';
130.        cursor++;
131.        (!row2);while
132.        }
133.      (!row3)else if
134.     {
135.        lcddata('8');
136.        pass[i++]='8';
137.        cursor++;
138.       (!row3); while
139.        }
140.      (!row4)else if
141.     {
142.        lcddata('0');
143        pass[i++]='0';
144.        cursor++;
145.       (!row4); while
146.        }
147.     col3= ;0
148.     col1=col2=col4= ;1
149. (!row1)if
150.     {
151.        lcddata( ');'3

151. pass[i++]='3';
152.        cursor++;
153        (!row1);while
154.       }
155.      (!row2)else if
156.     {
157.       lcddata('6');
158.      pass[i++]='6';
159.        cursor++;
160.        (!row2);while
161.       }
162.    (!row3) else if
163.     {
167.        lcddata('9');
168.        pass[i++]='9';
169.       cursor++;
170.      while(!row3);
171.        }
172     (!row4)else if
173.    {
174.       lcddata('#');
175.        pass[i++]='#';
176.        cursor++;
177.        (!row4);while
178.        }
179. col4= ;0
180.  col1=col3=col2= ;1
181. (!row1) if
182.    {
183.        lcddata( );'A'
184        pass[i++]='A';
185.        cursor++;
186.       (!row1); while
187.        }
188.     (!row2) else if
189.    {
190.        lcddata( ');'B
191.        pass[i++]='B';
192.        cursor++;
193.        while(!row2);
194.        }
195. (!row3)else if
196.     {
197.        lcddata( ');'C
198.        pass[i++]='C';
199.        cursor++;
200.       (!row3); while
201        }
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Program:

202. (!row4) else if
203.     {
204.        lcddata( );'D'
205.        pass[i++]='D';
206.        cursor++;
207.        while(!row4);
208.          }
209.   (i>0)  if
210.     {
211.      (flag!=cursor)   if
212.         delay(100);
213.         lcdcmd(cursor-1);
214.         lcddata( );'*'
215.     } 
216. }      
217.}
218. accept()void 
219. {
220.    lcdcmd(1);
221.     lcdstring("Welcome");
222.     lcdcmd(192);
223.   lcdstring( );"Password Accept"
224.     delay(200);
225. }
225. void wrong()
226. {  buzzer=0;
227.            lcdcmd(1);
228.     lcdstring( );"Wrong Passkey"
229.    lcdcmd(192);
230.    lcdstring( );"PLZ Try Again"
231.    delay( );200
232.    buzzer= ;1
233. }
234. void main()
235. {
236.    buzzer= ;1
237.    lcd_init();
238.    lcdstring( );"AMOTECH LABS"
239.    lcdcmd(0x );c0
240.   lcdstring( );"   PUNE     “
241.   delay( );1000
242.    lcdcmd(1);
243.    lcdstring( ");"Electronic Code
244.    lcdcmd(0xc0);
245.    lcdstring( ");"  Lock System  
246.    delay( );400

247. (1) while
248.   {
249.            i=0;
250.            keypad();
251.           (strncmp(pass,"4201",4)== ) if 0
252.            {
253.            accept();
254.            lcdcmd( );1
255.            lcdstring( );"Access Granted "
256.            delay( );300
257.                }
258.         else
259.        {
260.           lcdcmd(1);
261.           lcdstring( );"Access Denied"
262.           wrong();
263.           delay( );300
264.        }
265.
266.    }
267. }



     
       Aim: To study the ADC Interfacing with AT895S2     

 

Procedure:

1. Read the ADC Interfacing Program on the next page with all the comments explaining the 
program 

2. Open the Project folder for the program in Keil µVision IDE or create a new project following 
the procedure explained in the Keil manual. Build the project and generate the HEX file. 

3. Use Keil Programmer or another suitable tool to download the HEX file to the 8051 
microcontroller. 

4. Make sure that the jumper is used for internal ADC or Lm35.                                      

.   
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            Lab 5 - ADC Interfacing                                                                            
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1.   #include<reg51.h>
2.   sbit  D7=P3^ ;      7  //Ard D2
3.   sbit  D6=P3^ ;       6  //Ard D3
4.   sbit  D5=P3^ ;       5 //Ard D4
5.   sbit  D4=P3^ ;      4  //Ard D5
6.   sbit  rs = P3^ ;      2 /* Register select pin */  //Ard D8
7.   sbit  en =P3^ ;3
        /* Enable pin */           //Ard D7
8. int  LCD_Port ;
       //#define LCD_Port P1
9.   sbit  rd=P1^ ;     1 //ADC Part
10. sbit  wr=P1^ ;2
11. sbit  intr=P1^ ;3

12. unsignedchar  adc(), get_value, conv;
13. int I;

14. void unsignedintdelay(   count) /* Function to provide delay Approx 1ms with 11.0592 Mhz crystal*/
15. {
16.  int i,j;
17. for(i=0;i<count;i++)
18. for(j=0;j<112;j++);
19. }

20. void char LCD_Command (  cmnd)    /* LCD16x2 command funtion */
21. {
22. LCD_Port = (cmnd & )>> ;    0xF0 4 /* Send upper nibble */
23. D7=LCD_Port& ;0X08
24. D6=LCD_Port& ;0X04
25. D5=LCD_Port& ;0X02
26. D4=LCD_Port& ;0X01
27. rs= ;        0  /* Command reg. */
28. en= ;        1 // rw=0; /* Write operation */
29. delay( );1
30. en= ;0
31. delay( );2

32. LCD_Port = (cmnd & );    0x0F /* Send lower nibble */
33. D7=LCD_Port& ;0X08
34. D6=LCD_Port& ;0X04
35. D5=LCD_Port& ;0X02
36. D4=LCD_Port& ;0X01
37. rs= ;0
38 en= ;        1  /* Enable pulse */
39. delay( );1
40. en= ;0
41. delay( );5
42. }
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43.  LCD_Char (  char_data)   void char /* LCD data write function */
44. {
45.  LCD_Port =(char_data & )>> ; 0xF0 4 /* Send upper nibble */
46.  D7=LCD_Port& ;0X08
47. D6=LCD_Port& ;0X04
48. D5=LCD_Port& ; 0X02
49. D4=LCD_Port& ;0X01
50. rs= ;       1 /*Data reg.*/
51. // rw=0; /*Write operation*/
52. en= ;1
53. delay( );1
54. en= ;0
55. delay( );2

56. LCD_Port = (char_data & );  0x0F /* Send lower nibble */
57. D7=LCD_Port& ;0X08
58. D6=LCD_Port& ;0X04
59. D5=LCD_Port& ;0X02
60. D4=LCD_Port& ;0X01
61. en= ;       1 /* Enable pulse */
62. delay( );1
63. en= ;0
64. delay( );5
65.  }

66.  LCD_String (  *str)   void char  /* Send string to LCD function */
67. {
68.  I;int
69. (i= ;str[i]!= ;i++)     for 0 0 /* Send each char of string till the NULL */
70. {
71.  LCD_Char (str[i]);    /* Call LCD data write */
72. }
73. }

74.  LCD_String_xy (  row,  pos,  *str)  void char  char char  /* Send string to LCD function */
75. {
76.  (row == )if 0
77.  LCD_Command((pos & )| );0x0F 0x80
78.  (row == )else if 1
79.  LCD_Command((pos & )|0xC0);0x0F
80.  LCD_String(str);     /* Call LCD string function */
81. }
82. LCD_Init ( )      void void /* LCD Initialize function */
83. { 
84. delay( );     20 /* LCD Power ON Initialization time >15ms */
85. LCD_Command ( );   0x02 /* 4bit mode */
86. LCD_Command ( );   0x28 /* Initialization of 16X2 LCD in 4bit mode */
87. LCD_Command ( );  0x0C /* Display ON Cursor OFF */
88. LCD_Command ( );   0x06 /* Auto Increment cursor */
89. }
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90. unsigned char adc()
91. {
92.       wr= ;0
93. (i= ;i< ;i++);  for 0 1000
94.             rd= ;1
95.   (i= ;i< ;i++);for 0 1000
96.        wr= ;1
97. (i= ;i<1000;i++);  for 0
98.        (intr== );while 1
99.   rd= ;0
100.   conv=P0;
101.   return conv;
102. }
103. void main()
104.{
105.  LCD_Init();    /* Initialization of LCD*/
106.  LCD_String(" ");ADC OP:
107.  ( )while
108. {
109.          get_value = adc();
110.          LCD_Command( );0x87
111.          LCD_Char ((get_value/ )+ );100 48
112.          LCD_Char (((get_value/ )% )+ );10 10 48
113.          LCD_Char ((get_value% )+ );10 48
114.      
115.         //  LCD_Char (0x60);
116.         // LCD_Char ('C');
117.     delay( );200
118     }
119. }
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